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Instrument QC and Calibration with nanoRainbow Beads 
Purpose 
Assess fluorescence resolution and laser alignment and calibrate instrument flow rate using 

Cellarcus vCal™ nanoRainbow beads (nRBs). First-time users will need to download the vFC™ 

SpectroFlo Experiment Template from the Cellarcus website (or perform Instrument Setup and 

create a vFC™ Assay Experiment Template for data as described in Appendix A). 
 

Materials 

Materials to be Provided by user 

• Gloves  

• Microwell plate (Sartstedt 82.1583.001) or suitable tube. 

• Cellarcus SpectroFlo Template – Aurora.zip (Cellarcus web site) 

• FCS Express or FCS Express Reader software (FCS Express Reader) –  

Before first use, refer to Instrument-specific instructions in Notes (page 8). 

Procedure 
1. Open a New Experiment by opening the Cellarcus SpectroFlo Template - Aurora.zip 

(downloaded from the Cellarcus web site or created during Instrument Setup, see 

Appendix A). 

2. In the Acquisition dialogue, set Events to Display to 500,000 to ensure that all data are 

displayed.  

 

Kit Component Size  Store  

vCalTM nanoRainbow beads (CBS6 – 2.5 mL) 2.5 mL  4°C 

vCalTM Instrument QC and Qualification data analysis Layout    

https://denovosoftware.com/reader/
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Under Instrument Control – Voltage set the gain for all of the scatters to 2000 and set the gain 

for all of the fluorescence channels to 2000. 

Under Instrument Control – Threshold set the channel to the vFRed Parameter (B6-A) and set 

the threshold to 1100. 

Under Instrument Control – Signal make sure B6-W (vFRed) is chosen for the width values.  

 

You may choose to save/load the Instrument Control Settings file (see screenshot above). This 

shouldn’t be necessary since the Instrument Control Settings are saved with the well/tube slots 

in the experiment. 

 

3. Click Save to save the new Settings. 

4. Vortex nanoRainbow beads well. 

Table A4     

Dialogue Setting vCalTM beads Buffer Bkgd vFCTM assay 

Acquisition 
Settings 

Active Channels All channels All channels All channels 

 Scatter gain  
(FSC, SSC, SSC-B) 

2000  
(SSC: 15 w/ESP) 

2000  
(SSC: 15 w/ESP) 

2000  
(SSC: 15 w/ESP*) 

 Fluorescence gain 
(all channels) 

2000 2000 2000 

 Primary Threshold: SSC-H SSC-H B6-H 

 Manual Threshold: 50,000  500 1100 

 Width Parameter: B6-W B6-W B6-W 

Stopping Rules Time to Record Checked: 30 sec Checked: 30 sec Checked: 120 sec 

 Events to Record Unchecked Unchecked Unchecked 

Acquisition Events to Display 500,000 500,000 500,000 

 Sample Flow Rate High  High  High  

* Enhanced Small Particle (ESP) detector option installed.  
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5. Place five drops (~250 uL) undiluted nanoRainbow beads in the Protocol A+B Group - Well 

H3 (or tube). 

6. Select Well H3 and click Start. Inspect the light scatter plot to make sure the beads are on 

scale and singlets can be gated.  

7. Set the flow rate to High and Record the nanoRainbow bead sample for 30 seconds. 

8. Save the Experiment with a descriptive file name that includes the date. 
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Data Analysis 

Run SOP 
Open the Aurora (including Northern Lights) Instrument QC and Qualification data analysis 

Layout in FCS Express and run the SOP by going to Tools>Run SOP. 

Before the first use of FCS Express, select the instrument-specific options as instructed as 

specified in "READ ME FIRST" tab. 

 

Analysis 
1. Go to Data List (right side of page) and click the Add Data File icon to navigate to nanoRainbow data 

(.fcs) file. 

2. In the "Data List" window click on the nanoRainbow (.fcs) file then open the "Change File" menu and 
select "Change Data On All Plots" from the dropdown menu. 

3. Adjust nanoRainbows gate to include single beads (excluding background noise, doublets, etc). 

4. Inspect the time history for any fluidics issues. 

5. Inspect the fluorescence histograms of a representative channel from each laser and adjust the 
markers to select each of the four bead populations. 

6. Laser alignment is assessed by inspecting the CV of the bright bead population, which should be 
<15%. If CVs are higher, or there is an apparent leftward shoulder to the peak, alignment on that 
laser may be sub-optimal. 

7. Fluorescence resolution is assessed via the Separation Index (SI), which reflects the resolution of dim 
signals from background by comparing the difference between the blank and dimmest bead to the 
standard deviation of the background. This semi-quantitative metric is useful for an initial analysis of 
instrument performance, and the vFRed™ SI should be >3.0 to ensure efficient EV detection. 

8. Set the "nRB Pk4 Singlets", "nRB Pk4 Doublets", and "nRB Pk4 Triplets" on the appropriate 
populations. The Layout will calculate the sample flow rate using the known concentration of the 
nanoRainbow beads (5e5/mL). 

9. Go to File>Save As to save the layout with a descriptive name.  
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Figure Instrument QC and Qualification. A. Single nanoRainbow beads are gated by light scatter. B. The laser 
and fluidic alignment is assessed by the Peak 4 (Bright) CV, while the fluorescence resolution is assessed using 
the Separation Index, which reflects the resolution between Peak 2 (Dim) and Peak 1 (Blank). C. The sample 
flow rate is estimated from the number of Peak 4 (Bright) beads, including doublets and triplets, measured for 
a fixed time.  
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Notes 
Before loading data files, configure FCS Express Options to merge raw and unmixed 

parameters: 

File>Options>Data Loading> Instrument Specific Settings> Cytek - SpectroFlo> 

 1. Cytek File Merge Rule:  Merge both Raw and Unmixed Always 

 2. Delete fluorescence parameters after spectra merge: Uncheck  

Click: OK 

Note: You need to load the unmixed version of the file. If you just changed the settings then 

you will need to change files on all plots before changes take effect. 
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Appendix A. Instrument Setup – Cytek Aurora and Northern Lights 

Step 1. Create an Experiment Acquisition Template. 
The Cytek acquisition settings are stored in an .expt file, which contains data acquisition settings 

as well as the file and group naming rules applied to file names and Sample IDs. Frequently used 

plate layouts can be saved and used as templates for future experiments.  

This Template will be used to measure both beads, including vCalTM nanoRainbow Beads 

(Protocol A Instrument QC and Qualification) and vCalTM Antibody Capture Beads (Protocol B 

Fluorescence Unmixing and Calibration) and vesicles, including vCalTM Lipo100TM Vesicle Standard 

(Protocol B2) as part of Fluorescence Unmixing and Calibration and for most vFCTM assays, 

including measuring EV concentration and size (Protocol 1) and measuring EV surface markers 

(Protocol 2). 

The beads are detected using light scatter triggering to measure the bead fluorescence 

intensity, while vesicles are detected using fluorescence triggering (vFRed Fluorescence, B6) 

and fluorescence measured under the same instrument conditions (flow rate, laser power, 

detector gain). 

Before creating a template for vFC™ you need to add the vFRed Fluorescence tag to the 

SpectroFlo Fluorophore Library (Figure A1). To do this go to Library then select the blue laser 

and finally click “Add fluorescence tag.”  

 

Figure A1. SpectroFlo Fluorophore Library. 
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Table A1 shows the dyes that should be present in the Experiment Spectral Library. need  

 

You will also need to import a set of keywords. To do this go to Library>Keywords then click 

Import under Keyword groups then load the .csv file containing the Cellarcus keywords in the 

proper format. You may also add additional keywords or create your own keyword groups but 

our layouts will work best with the Cellarcus keywords. 

 

 

 

Table A1     

Detector 
Parameter Name 
($PnN) 

Laser 
EX-EM/BP Stain Name ($PnS) 

1 B06 Blue B6 vFRed 

2 B02 Blue B2-525/17 AlexaFluor488 

3 YG01 YellowGreen YG1-577/20 PE 

4 YG03 YellowGreen YG3-615/20 PEDazzle 

6 YG09 YellowGreen YG9-780/30 PECy7 

7 V01 Violet V1-428/15 BV421 

8 V07 Violet V7-542/17 BV510 

9 V10 Violet V10-615/20 BV605 

11 R01 Red R1-660/17 APC 

12 R02 Red R2-678/18 AlexaFluor647 
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To configure the initial vCalTM and vFCTM Combined Acquisition Template (.expt file), create a 

New Experiment (Acquisition > Select an experiment > New), then follow steps below. To edit an 

existing experiment open the experiment then click “Edit.” 

 

Note: Steps 1a and the first part of 1b to define the fluorescent tags and Reference Group are 

required for spectral unmixing in SpectroFlo, but not for conventional analysis with post-

acquisition compensation (or unmixing). 

a. Fluorescent Tags Tab – Add Fluorescence Tags (needed for unmixing in Spectroflo) 
At the top of this first tab you can set a name and description for the experiment. Add vFC 

fluorescence tags from the Spectral Library. vFRed should have already been added to the 

spectral library (see screenshot above). To find tags quicker use the “Type to filter” search bar. 

Click next. 
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b. Groups Tab – Create Reference Group and Sample Group(s) 
Tubes: If you are using tubes to collect data then Right click on the experiment group then 

select Add Reference Group and new window will open (see below). 

Plates: If you using plates/wells change Carrier Type to “96 U-Bottom” then click “Add Plate.” 

Then select a group of wells one for each control (13 total). Hold click and drag to select 

multiple wells at once. Hold shift and click to add additional single wells. Once you have 

selected your wells then click the middle folder on the right side of the window (see below). 
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Check “Define Universal Negative Control(s) for Spillover Calculation” and a new section will 

appear. Click “Add” to create a new negative control. Name the new negative control “Buffer” 

and set the control type to “Cells.” 

Under Fluorescent Tags section ensure that the positive controls have the appropriate control 

type and negative control set (vFRed should be Cells and Buffer and the rest should use the 

Unstained Bead control). Enter appropriate Labels for each positive control. Click Save.  

 

Tubes: Set Carrier type to “Manual Tube” 

Protocol A: Add a group. Name it “yymmdd Prot A” then add 1 tube. 

Protocol B: Add a group. Name it “yymmdd Prot B” then add 13 tubes. 

Protocol 1: Add a group. Name it “yymmdd Prot 1” then add 16 tubes. 

Protocol 2: Add a group. Name it “yymmdd Prot 2” then add 32 tubes. 
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Plates: Set Carrier type to “96 U-Bottom” (or whatever plate type you are using). Add 3 plates. 

Name them something like “plt1,” “plt2,” and “plt3” (shorter is better). 

Protocol A: Add a group to plt1. Name it “yymmdd Prot A” then add 1 tube. 

Protocol B: Add a group to plt1. Name it “yymmdd Prot B” then add 13 tubes. 

Protocol 1: Add a group. Name it “yymmdd Prot 1” then add 16 tubes. 

Protocol 2: Add a group. Name it “yymmdd Prot 2” then add 32 tubes. 

 

Click Next. Click Next (Skip Markers tab).  
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c. Keywords Tab – Keywords 
Drag the “Cellarcus Keywords” group over to the top row of the empty keyword column. 

 

Click Next. 

d. Acquisition Tab – Set Acquisition Settings 
Protocol A - Set Stopping Time to 30 seconds. Set Events to Record to 100,000. 

Protocol B – For bead wells (A1-F2), set Stopping Time to 10,000 seconds. Set Events to Record 

to 5000. For vFC Buffer and Lipo100+vFRed wells (F1,F2) set Stopping Time to 120 seconds. Set 

Events to Record to 100,000. 

Protocols 1 & 2 – Set Stopping Time to 120 seconds. Set Events to Record to 100,000. 

Tubes: 
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Plates:  

 

Click Next. 

e. Loader Settings Tab – Set Run Order (Plate Only) 
Click on Loader Settings on the right side of the screen (Plates only).  

Specify the Run Order to be by Columns ↓↓↓ (Plates only).  

 

Click Save and Open (Plates only) 
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f. Setup vCal™ Beads Worksheet – Define Acquisition Plots and Gates 
Start with the default raw worksheet. Create the histograms and gates to assess the sample 

during data acquisition (Table A2). During data acquisition, the Singlet beads (Gate 1) will be 

adjusted to facilitate visual inspection during acquisition. Analysis of the data will take place in 

the appropriate vCalTM Bead Report layout. 

 

*Bright Channels (5 Laser): R1, R2, B1, B2, B5, YG1, YG3, YG9, V1, V7, V10 

*Bright Channels (3 Laser): R1, R2, B1, B2, B4, B6, B13, V1, V7, V10 

*Bright Channels (1 Laser): B2, B4, B6, B13 

g. Setup vFC Assay Worksheet – Define Acquisition Plots and Gates. 

Start with the default worksheet since it includes all the parameters. Ensure the following 1- 

and 2-parameter plots are present and draw gates to view data during acquisition (Table A3). 

These plots are only for visual inspection during acquisition. Analysis of the data will take place 

in the appropriate vFCTM Report layout. 

 

  

Table A2  

Plot/Gate: Description Purpose 

Plot 1: Time Monitor fluidic stability 

Plot 2: SSC-A vs FSC-A Gate singlet beads 

Gate 1: Singlet gate Select single beads and exclude doublets and background 

Plots 3-n: Bright Channels* Individual fluorescence channel intensity resolution 
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Table A3  

Plot/Gate: Description Purpose 

Plot 1: VSSC-A vs Time Monitor fluidic stability 

Plot 2: Time Monitor fluidic stability 

Gate 1: Time gate Exclude the first 20 sec and collect the final 100 sec. 

Plot 3: vFRed-A vs vFRed-H Monitor event pulse characteristics 

Gate 2: Pulse width gate Exclude short pulse width background events 

Plot 4: vFRed-A vs VSSC-H Monitor event vFRed and VSSC intensities 

Gate 3: Vesicle gate Select events characteristic of single vesicles, exclude high- and low-VSSC events. 

Plot 5: PE-A vs vFRed-A Monitor PE immunofluorescence 

Gate 4: PE positive Estimate number of “PE positive” events 

Additional Plots and Gate For additional immunofluorescence channels as needed/desired 

 

h. Instrument Control – Set Instrument Settings  
Click on Acquisition Control below the Plate Window under Acquisition. 

 

In the Acquisition dialogue, set Events to Display to 500,000 to ensure that all data are displayed.  
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Under Instrument Control – Voltage set the gain for all of the scatters to 2000 and set the gain 

for all of the fluorescence channels to 2000. 

Under Instrument Control – Threshold set the channel to the vFRed Parameter (B6-A) and set 

the threshold to 1100. 

Under Instrument Control – Signal make sure B6-W (vFRed) is chosen for the width values.  

 

You may choose to save/load the Instrument Control Settings file (see screenshot above). This 

shouldn’t be necessary since the Instrument Control Settings are saved with the well/tube slots 

in the experiment. 

i. Save As – Save the data acquisition template 
Click Save As to save a Template. Give the template a descriptive name so it won’t be confused 

with any other templates. 

Table A4     

Dialogue Setting vCalTM beads Buffer Bkgd vFCTM assay 

Acquisition 
Settings 

Active Channels All channels All channels All channels 

 Scatter gain  
(FSC, SSC and SSCB) 

2000  
(SSC: 15 w/ESP) 

2000  
(SSC: 15 w/ESP) 

2000  
(SSC: 15 w/ESP*) 

 Fluorescence gain 
(all channels) 

2000 2000 2000 

 Primary Threshold: SSC-H SSC-H B6-H 

 Manual Threshold: 50,000  500 1100 

 Width Parameter: B6-W B6-W B6-W 

Stopping Rules Time to Record Checked: 30 sec Checked: 30 sec Checked: 120 sec 

 Events to Record Unchecked Unchecked Unchecked 

Acquisition Events to Display 500,000 500,000 500,000 

 Sample Flow Rate High  High  High  

* Enhanced Small Particle (ESP) detector option installed.  



 Instrument QC and Qualification 
For the Cytek Aurora and Northern Lights 

 

Copyright 2024 Cellarcus Biosciences Inc. All rights reserved. Rev 250512 

18 
 

Various settings that should be associated with the template are summarized below (if you did 

the previous steps correctly). 

Appendix B. Data Acquisition 

1. vCal nanoRainbow and nanoCal antibody capture bead measurement 

a. Load Assay Template and Settings 

If you downloaded a Cellarcus SpectroFlo Experiment Template and haven’t yet saved it as a 

template, load it then click Save As to save a template. Give the template a descriptive name so 

it won’t get confused with any other templates. 

 

Load an experiment template configured for either plates or for tubes (downloaded from 

Cellarcus or produced as described in Appendix A). The template should have your instrument 

set up with the appropriate Instrument Control Settings applied to the relevant sample 

tubes/wells.  

• At the Import Options dialog box, check “Import as new item” to avoid overwriting 

previous versions.  



 Instrument QC and Qualification 
For the Cytek Aurora and Northern Lights 

 

Copyright 2024 Cellarcus Biosciences Inc. All rights reserved. Rev 250512 

19 
 

 

b. Set Experiment Name, Group Name(s), and File Names 

Give your experiment a name. Include the date of the experiment at the beginning in the form 

of YYMMDD (so sorting by name sorts by date of experiment). Include some information about 

the experiment as well. 

Edit group names so that the YYMMDD part is replaced with the date the group (possibly same 

as experiment date above) will be run. 

Double-click each well/tube and rename to include the sample, any dyes added, and the date 

(note that there is an option to auto-add the date but it will also include time and group, 

lengthening the file path).  
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c. Fill in Keyword Values 

Open the Edit Experiment window then go to the Keywords tab.  

 

The first keyword to edit is $CELLS which should include particle type (eg. type of ev, type of 
bead, or type of cell). If you are using the Cellarcus SpectroFlo Template, edit any values in 
brackets which correspond to tube/well of each sample.  

The second keyword is $SMNO which should contain the fluorescent markers included in the 
sample. If you are using the Cellarcus SpectroFlo Template, replace the brackets with the list of 
dyes. 

The third keyword is $COM is for comments and you may choose to include any extra 
information that you want included in the data file for a given sample.  

The fourth keyword is $PROJ which is for the experiment name and will likely be the same for 
all samples of a given experiment.  

The fifth and final keyword is $SRC which is for the source of the sample. For standards 
provided with our kit it could be something like “Cellarcus Biosciences” (which is the default).  

d. [Protocols 1&2 Only] Adjust Trigger Channel Threshold.  

Load a well of vFCTM Staining Buffer and allow system to run for 15 seconds on high flow rate 

(60ul/min).  Ensure that the blue laser-excited, B6-H (vFRed) fluorescence channel is set at a 

threshold of 1100, then adjust the manual threshold until you get 10-15 events/second in a Buffer 

Only sample. Apply this threshold to all wells/tubes in Protocols 1 and 2 and to the vFRed control 

well/tube in Protocol B. Save the Template file (.expt) for future use. In general, once optimized 

the threshold does not need to be changed every time you run an experiment. 

e. Auto Record data.  

You are now ready to run samples. Click Auto Record to run the selected Sample wells. 


